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Chapter 487

Tests for the Matched-Pair
Difference of Two Event
Rates in a ClusterRandomized Design
Introduction
Cluster-randomized designs are those in which whole clusters of subjects (classes, hospitals, communities, etc.)
are sampled, rather than individual subjects. This sample size and power procedure is used for the case where the
subject responses are counts (event rates). To reduce the variation (and thus increase power), clusters are matched,
with one cluster of each pair assigned to the control group, and the other assigned the treatment group. This
procedure gives the number of pairs needed for the desired power requirement.
The formulas used here are based on Hayes and Bennett (1999) and Hayes and Moulton (2009). The methods are
discussed in Donner and Klar (2000) and briefly in Campbell and Walters (2014).

Technical Details
Definition of Terms
The following table presents the various terms that are used.
Group

1 (Control)

2 (Treatment)

Sample size:

𝐾𝐾

𝐾𝐾

Individual event rates:

𝜆𝜆1

𝜆𝜆2

Coefficient of Variation: 𝐶𝐶𝐶𝐶𝑀𝑀 (within-pair coefficient of variation between clusters in the absence of
intervention)
Number of cluster pairs: 𝐾𝐾 (2K is the total number of clusters)

Person-Years per cluster: 𝑀𝑀
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Hypotheses
The null and alternative hypotheses are
𝐻𝐻0 : 𝜆𝜆𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷 = 0 vs. 𝐻𝐻1 : 𝜆𝜆𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷 ≠ 0

Corresponding one-sided hypotheses may also be used. These hypotheses may be tested based on an appropriate
paired difference test.

Sample Size and Power Calculations
Sample Size Calculation
The sample size calculation for the number of cluster pairs, as given in Hayes and Bennett (1999) and Hayes and
Moulton (2009), is
2 (𝜆𝜆1

𝐾𝐾 = 2 + �𝑧𝑧𝛼𝛼/2 + 𝑧𝑧𝛽𝛽 �

+ 𝜆𝜆2 )⁄𝑀𝑀 + 𝐶𝐶𝐶𝐶𝑀𝑀2 (𝜆𝜆12 + 𝜆𝜆22 )
(𝜆𝜆1 − 𝜆𝜆2 )2

Estimating CVM
Hayes and Bennett (1999) suggest that 𝐶𝐶𝐶𝐶𝑀𝑀 may be estimated based on the following, if prior data is available:

Let λij represent the true event rate in the jth cluster (j = 1,2) of the ith pair (i = 1,…,M) and rij represent the
corresponding observed rate. The empirical variance of the ith pair is given by
𝑠𝑠𝑖𝑖2 = (𝑟𝑟𝑖𝑖2 − 𝑟𝑟𝑖𝑖1 )2⁄2

Define

as the average of the within-pair variances.
𝐶𝐶𝐶𝐶𝑀𝑀 may be estimated from

2
= � 𝑠𝑠𝑖𝑖2 �𝑀𝑀
𝑠𝑠𝑚𝑚

𝐶𝐶𝐶𝐶𝑀𝑀2 =

2
− 𝐴𝐴𝐴𝐴(𝑟𝑟𝑖𝑖 /𝑦𝑦𝑖𝑖𝑖𝑖 )
𝑠𝑠𝑚𝑚
𝐴𝐴𝐴𝐴(𝑟𝑟𝑖𝑖2 )

where 𝑦𝑦𝑖𝑖𝑖𝑖 is the person-year of follow-up in the ith pair of the jth cluster, and Av() indicates the mean over all M
clusters.

According to Hayes and Bennett (1999), “If only unmatched data are available, a conservative approach is to use
[the coefficient of variation (SD/Mean) between clusters within each group] as an upper limit for 𝐶𝐶𝐶𝐶𝑀𝑀 .”
If no data is available, a series of plausible values, usually between 0 and 0.5, should be considered.

Power Calculation
The corresponding power calculation to the sample size calculation above is
(𝐾𝐾 − 2)(𝜆𝜆1 − 𝜆𝜆2 )2
𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 = 1 − Φ ��
− 𝑧𝑧𝛼𝛼/2 �
(𝜆𝜆1 + 𝜆𝜆2 )⁄𝑀𝑀 + 𝐶𝐶𝐶𝐶𝑀𝑀2 (𝜆𝜆12 + 𝜆𝜆22 )

where 𝑧𝑧𝑥𝑥 = Φ(𝑥𝑥) is the standard normal distribution function.
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are Power, K, M, and λ2.
Under most situations, you will select either Power to calculate power or K to calculate the number of cluster
pairs. Occasionally, you may want to fix the number of clusters and find the necessary cluster size.
The value selected here always appears as the vertical axis on the charts (when applicable).
When searching for M, some scenarios with small K’s are not feasible.

Test
Alternative Hypothesis
Specify whether the test is one-sided or two-sided. The one-sided option specifies a one-tailed test.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis
is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (beta = 0.20) was used for power. Now, 0.90
(beta = 0.10) is commonly used.
A single value may be entered or a range of values, such as 0.8 to 0.95 by 0.05, may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected.
Values must be between zero and one. Usually, the value of 0.05 is used for two-sided tests and 0.025 is used for
one-sided tests.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
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Sample Size – Number of Clusters & Cluster Size
K (Number of Cluster Pairs)
This is the number of cluster pairs. Each cluster pair consists of two clusters that are matched or paired based on
one or more criteria. The total sample size is equal to the number of clusters times the person-years per cluster.
This value must be a positive number. You can enter a single value such as 20 or a series of values such as 10 20
30 or 10 to 30 by 5.
M (Person-Years per Cluster)
This is the average number of person-years per cluster. This value must be a positive number that is at least 1. It
can be a decimal (fractional) number such as 2.7. The name person-years is used for this parameter. However, we
could have used person-time or person-week or person-day. It refers to a count of the number of events over a
fixed time period. The scale of λ1 and λ2 should be in consistent with the Person-Years scale. λ1 and λ2 represent
rates over a specific duration. You can enter a single value such as 50 or a series of values such as 40 50 60 or 40
to 60 by 5.

Effect Size
λ1 (Event Rate of Group 1)
Enter a value (or range of values) for the mean event rate per unit time in group 1 (control group). The value must
be greater than zero.
Example of Estimating λ1
If 200 patients were exposed for 1 year and 40 experienced the event of interest, then the mean event rate would
be
λ1 = 40/(200*1) = 0.2 per patient-year
If 200 patients were exposed for 2 years and 40 experienced the event of interest, then the mean event rate would
be
λ1 = 40/(200*2) = 0.1 per patient-year
Event Rate Difference
λ1 is used with λ2 to calculate the event rate difference as
Diff = λ2 - λ1
such that
λ1 = λ2 - Diff
The range of acceptable values is λ1 > 0. You can enter a single value such as 1 or a series of values such as 1 to 2
by 0.5.
Enter λ2, Diff, or Ratio for Group 2
This option lets you indicates how λ2 is entered. The options are
•

λ2 (Event Rate of Group 2)
Enter the value of λ2 directly.

•

Diff (Difference Between Event Rates)
Enter values for the difference between the event rates (Diff = λ2 - λ1). The value of λ2 is equal to λ1 + Diff.
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•

RR (Ratio of Event Rates)
Enter values for the ratio of the event rates (RR = λ2 / λ1). The value of λ2 is equal to λ1 x Ratio. Note that
the hypothesis still concerns the difference. This is just a convenient way of specifying a value.

λ2 (Event Rate of Group 2)
This option is displayed only if Enter λ2, Diff, or Ratio for Group 2 = “λ2 (Event Rate of Group 2).”
Enter a value (or range of values) for the mean event rate per time unit in group 2 (treatment group). The value
must be greater than zero and different from λ1.
Example of Estimating λ2
If 200 patients were exposed for 1 year and 40 experienced the event of interest, then the mean event rate would
be
λ2 = 40/(200*1) = 0.2 per patient-year
If 200 patients were exposed for 2 years and 40 experienced the event of interest, then the mean event rate would
be
λ2 = 40/(200*2) = 0.1 per patient-year
Event Rate Difference
λ2 is used with λ1 to calculate the event rate difference as
Diff = λ2 - λ1
such that
λ2 = λ1 + Diff
The range of acceptable values is λ2 > 0. You can enter a single value such as 1 or a series of values such as 1 to 2
by 0.5.
Diff (Difference Between Event Rates)
This option is displayed only if Enter λ2, Diff, or Ratio for Group 2 = “Diff (Difference Between Event Rates).”
Enter values for the difference between the event rates (Diff = λ2 - λ1). The value of λ2 is equal to λ1 + Diff. The
range is any positive or negative value other than 0 (Diff ≠ 0). You can enter a single value such as 0.5 or a series
of values such as 0.5 0.6 0.7 or 1 to 6 by 1.
RR (Ratio of Event Rates)
This option is displayed only if Enter λ2, Diff, or Ratio for Group 2 = “RR (Ratio of Event Rates).”
Enter values for the ratio of the event rates (RR = λ2 / λ1) at which the power is to be calculated. The value of λ2
is calculated using λ1 x RR. The range is RR > 0 and RR ≠ 1. Typically, RR is between 0.5 and 2.0. You can
enter a single value such as 1.15 or a series of values such as 1.05 1.10 1.15 1.20 or 1.05 to 1.20 by 0.05.
CVM (Within-Pair Coefficient of Variation)
Enter a value or values for the within-pair coefficient of variation (SD/Mean) between clusters in the absence of
intervention. See the documentation or references for suggestions for estimating CVM. If prior information is not
available, Hayes and Bennett (1999) suggest that CVM is usually less than 0.25 and seldom greater than 0.50.
You can enter a single value such as 0.15 or a series of values such as 0.05 0.10 0.15 0.20 or 0.05 to 0.30 by 0.05.
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Example 1 – Calculating Sample Size
One difficulty in calculating sample size for a matched-pair difference of two event rates in a cluster-randomized
design is obtaining a value for CVM, the within-pair coefficient of variation between clusters. This example shows
how to enter a range of values to determine the effect of CVM on sample size. Suppose that a cluster randomized
study is to be conducted in which the control event rate is assumed to be λ1 = 0.80, and the treatment event rate is
λ2 = 0.58. Each cluster is assumed to have about 80 individuals. Each will be followed for one year. A range of
values between 0.05 and 0.5 for CVM will be examined. The desired power and alpha are 0.9 and 0.05,
respectively. The test will be a two-sided test.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for the Matched-Pair Difference of Two Event Rates in a Cluster-Randomized
Design procedure window. You may then make the appropriate entries as listed below, or open Example 1 by
going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ........................................................ K (Number of Cluster Pairs)
Alternative Hypothesis .................................... Two-Sided
Power .............................................................. 0.90
Alpha ............................................................... 0.05
M (Person-Years per Cluster) ......................... 80
λ1 (Event Rate of Group 1) ............................. 0.80
Enter λ2, Diff, or Ratio for Group 2 ................. λ2 (Event Rate of Group 2)
λ2 (Event Rate of Group 2) ............................. 0.58
CVM (Within-Pair Coefficient of Variation) ..... 0.05 to 0.50 by 0.05

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for a Two-Sided Test of Event-Rate Matched-Pair Difference in a Cluster-Randomized Design
Group 1 = Control. Group 2 = Treatment.

Power
0.9389
0.9064
0.9151
0.9167
0.9001
0.9022
0.9027
0.9025
0.9020
0.9013

Number
of
Cluster
Pairs
K
7
8
11
15
19
25
32
40
49
59

Total
Number
of
Clusters
2K
14
16
22
30
38
50
64
80
98
118

PersonYears
per
Cluster
M
80
80
80
80
80
80
80
80
80
80

Total
PersonYears
N = 2KM
1120
1280
1760
2400
3040
4000
5120
6400
7840
9440

Event
Rate
Gr 1
λ1
0.8000
0.8000
0.8000
0.8000
0.8000
0.8000
0.8000
0.8000
0.8000
0.8000

Event
Rate
Gr 2
λ2
0.5800
0.5800
0.5800
0.5800
0.5800
0.5800
0.5800
0.5800
0.5800
0.5800

Event
Rate
Diff.
λ2 - λ1
-0.2200
-0.2200
-0.2200
-0.2200
-0.2200
-0.2200
-0.2200
-0.2200
-0.2200
-0.2200

Event
Rate
Ratio
λ2 / λ1
0.73
0.73
0.73
0.73
0.73
0.73
0.73
0.73
0.73
0.73

Coefficient of
Variation
CVM
0.050
0.100
0.150
0.200
0.250
0.300
0.350
0.400
0.450
0.500

TwoSided
Alpha
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
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Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
K represents the number of cluster pairs needed in the design.
2K is the total number of clusters in the design, 2 clusters per pair.
M is the average number of person-years per cluster in all clusters.
N is the total number of person-years in the design. N = 2KM.
λ1 is the event (or incidence) rate of the control group. This is the baseline rate.
λ2 is the event (or incidence) rate of the treatment group.
λ2 - λ1 is the difference between the treatment event rate and the control event rate.
λ2 / λ1 is the ratio of the treatment event rate to the control event rate.
CVM is the within-pair coefficient of variation between clusters in the absence of intervention. See the documentation
or references for suggestions for estimating CVM.
Alpha is the probability of rejecting a true null hypothesis, that is, rejecting H0 when the event rates are actually
equal.
Summary Statements
A sample of 7 cluster pairs (14 clusters) with 80 person-years per cluster achieves 94% power
to detect a difference of -0.2200 between the treatment event rate 0.5800 and the control event
rate 0.8000. The within-pair coefficient of variation between clusters is 0.050. A two-sided
paired test of the event-rate difference is assumed, with a significance level of 0.050.
Chart Section

This report shows the needed number of cluster pairs for each of the coefficient of variation values.
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Example 2 – Validation using Direct Calculation
Hayes and Bennett (1999) and Hayes and Moulton (2009) give formulas for sample size for tests of the matchedpair difference in a cluster-randomized design for comparing event rates, proportions, and means. However, the
only example corresponds to the proportions case. Thus, we give an example where the number of cluster pairs
needed is determined by direct calculation.
We will consider the (two-sided) case where λ1 = 0.6; λ2 = 0.4; M = 200; alpha = 0.05; CVM = 0.25; Power =
0.80.
𝐾𝐾 = 2 + �𝑧𝑧𝛼𝛼 + 𝑧𝑧𝛽𝛽 �
2

2 (𝜆𝜆
1

= 2 + (1.9600 + 0.8416)2
= 2 + 7.84888

Setup

+ 𝜆𝜆2 )⁄𝑀𝑀 + 𝐶𝐶𝐶𝐶𝑀𝑀2 (𝜆𝜆21 + 𝜆𝜆22 )
(𝜆𝜆1 − 𝜆𝜆2 )2

(0.6 + 0.4)⁄200 + 0.252 (0.62 + 0.42 )
(0.4 − 0.6)2

0.005 + 0.0625(0.52)
= 9.358
0.04

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for the Matched-Pair Difference of Two Event Rates in a Cluster-Randomized
Design procedure window. You may then make the appropriate entries as listed below, or open Example 2 by
going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ........................................................ K (Number of Cluster Pairs)
Alternative Hypothesis .................................... Two-Sided
Power .............................................................. 0.80
Alpha ............................................................... 0.05
M (Person-Years per Cluster) ......................... 200
λ1 (Event Rate of Group 1) ............................. 0.60
Enter λ2, Diff, or Ratio for Group 2 ................. λ2 (Event Rate of Group 2)
λ2 (Event Rate of Group 2) ............................. 0.40
CVM (Within-Pair Coefficient of Variation) ..... 0.25

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for a Two-Sided Test of Event-Rate Matched-Pair Difference in a Cluster-Randomized Design
Group 1 = Control. Group 2 = Treatment.

Power
0.8318

Number
of
Cluster
Pairs
K
10

Total
Number
of
Clusters
2K
20

PersonYears
per
Cluster
M
200

Total
PersonYears
N = 2KM
4000

Event
Rate
Gr 1
λ1
0.6000

Event
Rate
Gr 2
λ2
0.4000

Event
Rate
Diff.
λ2 - λ1
-0.2000

Event
Rate
Ratio
λ2 / λ1
0.67

Coefficient of
Variation
CVM
0.250

TwoSided
Alpha
0.050

PASS calculates the number of cluster pairs needed to be 10, which matches the rounded-up calculation value.
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